# Table of Contents

Introduction ............................................................................................................................................ 1

**Outlook 2011: At-a-Glance** ............................................................................................................. 2
   Get easy access to the right tools, at the right time .............................................................. 2
   Save time viewing, creating, and managing your content .................................................. 2
   Deliver polished and professional communications .......................................................... 3
   Simplify your scheduling tasks ................................................................................................. 4
   Connect with people, connect your email accounts, and stay up-to-date .......................... 4
   Work how, when, and where you choose ............................................................................... 4

**Outlook 2011: A Closer Look** ...................................................................................................... 6
   Ribbon New! .............................................................................................................................. 6
   My Day Improved! ................................................................................................................... 8
   Conversations New! .................................................................................................................. 10
   Attachment previews New! ....................................................................................................... 12
   Outlook database Improved! .................................................................................................... 13
   Unified folders New! ................................................................................................................. 14
   Import Windows PST files New! .............................................................................................. 15
   Filter by Category New! ............................................................................................................ 16
   Filters and Search tools Improved! .......................................................................................... 18
   Help Improved! ......................................................................................................................... 20
   Rich email editing Improved! ................................................................................................... 22
   Media Browser New and Improved! ......................................................................................... 24
   Overlay calendar view New! ...................................................................................................... 26
   Calendar preview New! .............................................................................................................. 27
   Scheduling Assistant Improved! ............................................................................................... 28
   Reply with Meeting New! .......................................................................................................... 30
   Rich presence and on-the-spot communication Improved! .................................................. 31
   Contacts Search panel New! ...................................................................................................... 32
   Information Rights Management New! .................................................................................... 33
   Microsoft Outlook Web App Improved! ................................................................................... 35
   Offline Address Books ............................................................................................................ 36
   Voice mail preview New! ........................................................................................................... 37
Exploring Conversations .................................................................38
  Make the switch to Conversations ................................................38
  Conversations: General Tips ......................................................39
  Setting preferences for Conversations ........................................40

Conclusion ..............................................................................42

Where to Find It ....................................................................43

Application Comparison .......................................................48

Outlook 2011 FAQ ..................................................................56

Requirements/Disclosures .....................................................64

Colophon ..................................................................................66
Introduction

Microsoft® Outlook® for Mac 2011 (Outlook 2011), which replaces Entourage, offers you increased cross-platform compatibility along with premium business and personal email management tools. We know the average person reads about 1,800 messages per month and deletes about 1,500 of them. Even though email is important to you, don’t you wish you could spend less time managing it? Manage your day efficiently with Outlook 2011. From a familiar look and advanced search, sharing and scheduling features, to the ability to transfer your Outlook for Windows data files, Outlook 2011 helps you stay on top of your daily communications and agenda to get things done.¹

For many of us, email is a vital part of our everyday lives. We rely on mobile devices for communication and living the connected lifestyle. It’s how we stay in touch with friends, family, business, and the world at large. Whether you’re waiting for a flight, reading a book in a coffee house, or leaving a meeting with a client, you want your email available to you anytime, anyplace. Microsoft Exchange Server 2010 can provide anywhere access to your Outlook 2011 email, calendar, and address books, and they’re never farther away than your closest web browser or iPhone.² Connect with other people at work and at home when you’re on the go so you can keep in touch with the people that matter most.

Welcome to Outlook 2011 — our most powerful and Exchange compatible Mac email application yet.

¹ Import functionality is available for PST files created in Outlook 2003 for Windows or later.

² Web and smartphone access require both an appropriate device and an Internet connection. Web functionality uses Outlook Web App, which requires Microsoft Exchange Server 2010 and Safari 4 or later for Mac, Internet Explorer® 7 or later for Windows, and Firefox 3.5 or later for Windows, Mac, or Linux. There are some differences between the features of Outlook Web App and Outlook 2011.
Outlook 2011 At-a-Glance

Manage your content more easily
Outlook 2011 makes it easier for you to organize and manage the volume of email you receive and helps you stay on top of your busy schedule. Take a glance at how Outlook 2011 is designed to help increase your productivity and save time.

Get easy access to the right tools, at the right time
A new application can help you be more productive, but only if you can find the tools you need when you need them. Fortunately, Outlook 2011 provides a familiar Mac look and feel so you can focus on the end result, not how to get there.

- Work more intuitively. The ribbon makes it easy to discover and utilize the features Outlook 2011 has to offer. It adapts to your task at hand and enables you to work the way you want.

- View your schedule at-a-glance. Stay on top of your day through an improved version of My Day. View more meeting and appointment details, utilize new task management tools, and access your personal and corporate contacts without the need to start Outlook.

Save time viewing, creating, and managing your content
Think about how much time you spend working with your email and calendar in your typical week today versus your typical week five years ago. Outlook 2011 has been designed to reflect these changes in your lifestyle and help keep up with the vast amounts of information coming at you every day.

- Stay on top of your lengthy email discussions more easily. With the Conversations feature, lengthy email discussions can be summarized to help you gain control over your email and get more time back in your day to focus on other things.

- Save time viewing file attachments. Launch Quick Look right from your email message and preview your file attachments without opening them in individual applications.

- Do you work with more than one email account? No problem. Unified folders enable you to view and manage email from multiple accounts in a single Inbox.
Filter your calendar down to the relevant details. The **Filter by Category** feature enables you to view only those appointments assigned to the categories you specify in a few quick clicks. Easily manage your schedule and view exactly what you need, when you need it.

Quickly sift through your mailbox and locate what you’re looking for with ease. Use built-in Filters to apply frequently-used criteria in a few simple clicks. For more advanced filtering, a variety of handy **Search tools** are provided to help you fine-tune your results.

**Deliver polished and professional communications**

Over the years, email has evolved from one or two paragraphs of text to family or business newsletters, personalized stationery, agendas, and so much more. Whether your email is personal or business related, Outlook 2011 brings you rich composition tools to help you create professional content and maintain cross-platform compatibility.

- Rapidly turn information into action with beautifully formatted emails. Outlook 2011 provides rich **email editing tools**, such as hyperlinks, text highlight, multilevel lists, and support for tables, giving you more compatibility across platforms.

- Grab your readers’ attention by visually conveying your message. Access the **Media Browser** right from a new email message and quickly insert photos, movies, or audio files.

**Work more easily with others**

Communication and collaboration with your team, friends, or family plays a critical role in your everyday life. You need to accomplish your tasks seamlessly and without worrying about the operating system and email application someone else is using. Outlook 2011 brings you innovative tools to make sharing easy and hassle-free, whether you’re working with others across a cubicle wall or across platforms.

**Simplify your scheduling tasks**

Outlook 2011 provides easy ways to schedule meetings and work with shared calendars. Streamlined tools help you be more productive from more places so you can share and collaborate more efficiently and effectively.

- Stop switching back and forth between calendars. Outlook 2011 automatically displays multiple calendars, such as a shared Exchange calendar, in an **overlay view** so you can easily compare the details.

- Be more responsive to meeting invitations. See a **preview of your calendar** and accept a meeting invitation without leaving your inbox.
Schedule and manage your meetings more easily. If you’re an Exchange user, you can view more of your co-worker’s shared calendar details in the **Scheduling Assistant** and easily track attendee responses right from your meeting request.

**Connect with people, connect your email accounts, and stay up-to-date**

Whether you’re managing a team, organizing a family event, or catching up with friends, it’s important to stay connected to people inside and outside your office or home. Outlook 2011 brings together various email and communication networks so that staying connected with the people you care about is fast, simple, and fun.²

- Stay connected to your colleagues and friends. View the online availability of a person and instantly reach out to them using a variety of communication methods — all on an easy-to-access contact card.

- Instantly search your contacts from any Outlook view. The **Contacts Search panel** enables you to quickly search for a person in your personal contacts or your corporate global address list — even when you’re offline.

**Work how, when, and where you choose**

Like most of us, your deadlines and work emergencies don’t always conveniently occur when you are at your desk. Fortunately, with Exchange Server 2010 you have the power to get things done when and where you want.

When you’re away from your primary computer, check email anywhere and quickly locate those important addresses and phone numbers when you need them. Stay connected to your work and personal connections by taking the Outlook experience with you and stay on top of things while you’re on the go.

- Stay up to the minute and in touch. View your Outlook email messages, contacts, and calendar events stored on Exchange Server 2010 through your web browser with **Outlook Web App**.³

---

² Viewing presence information and initiating an IM, voice, or video conversation from within Outlook 2011 requires either Microsoft Messenger for Mac or Microsoft Office Communications Server 2007 R2 with Microsoft Communicator for Mac. Your computer must have an installed microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator for Mac.

³ Outlook Web App, formerly known as Outlook Web Access, is available to Microsoft Exchange customers.
Manage your content more easily

Outlook 2011 gives you the power to stay on top of your daily communications and simply your tasks. From a familiar environment, advanced organization and content management features, to rich email composition tools, increased productivity with Outlook 2011 is easier than you might imagine.
Ribbon

Locate the commands you need when you want them and where you want them. The new ribbon, available across the Microsoft Office for Mac 2011 applications, gives you a streamlined and flexible work experience. It’s designed to help you access the full range of features that Outlook provides — so that you can get more done in less time. The ribbon provides you exactly the tools you need, when you need them.

- The standard tabs you see on the ribbon are organized to display commands relevant to a given task, so that you can access what you need more quickly. They change based on your active view, such as when working with your calendar or contacts, to give you quick access to the best tools for the task at hand.

- The ribbon also provides contextual tabs to give you exactly the tools you need, when you need them. For example, when you click a meeting on your calendar, a Meeting tab will automatically appear in the ribbon, as shown in Figure 1, giving you an array of additional tools for working with your meeting without the need to open it.

Figure 1 - Click a meeting or appointment on your calendar and tools for working with that item automatically display on the ribbon.
**Quick Tips:**

- Double-click any tab name (such as Home or Organize) to minimize or expand the ribbon. Or, click the ▲ or ▼ button on the right edge of the ribbon to minimize or expand the ribbon.

- The ribbon is designed to give you fast, familiar, and easier access to more features — not to make you change the way you work. With that in mind, Office 2011 provides the menus and core toolbars that you may know from other applications, such as Entourage.
My Day

My Day received a facelift in Office 2011. Your upcoming meetings and appointments now display in a familiar, streamlined vertical timeline — just like the Day view of your calendar in Outlook. Easily view a slice of time at-a-glance and quickly see how your appointments relate to each other. With My Day, it’s easy to stay on top of your schedule and manage your time more efficiently.

- View calendar details without switching to Outlook. Click a meeting or appointment in My Day to view more information about that item. For example, if a meeting invitation is selected, you’ll see the attendee list — including online presence status if the attendee is a Communicator or Messenger contact — meeting notes, and more.

Figure 2 - Easily see how your upcoming appointments affect your schedule and get the details you need without switching to your Outlook calendar.
• New tools for your tasks. When you create a new task you can now include additional details, such as the date a task is due, add notes, or assign your task to a category, as shown in Figure 2. You can also easily toggle between your current tasks and those you’ve already completed.

• Interact with your contacts without switching to Outlook. The newly added ability to search for your contacts enables you to find a contact and quickly send them an email or meeting invitation. Just click the Contacts button at the bottom of My Day and start typing to instantly search your contacts.

Quick Tip: Manage your tasks right from My Day. Right-click (or hold the CONTROL key and click) a task to display a menu that provides you with the ability to delete a task, modify the category, or assign a Follow Up flag.
Conversations

The Conversations feature in Outlook 2011 helps you get straight to the relevant facts. It condenses multiple emails in a discussion, called a conversation thread, and displays them as a single line item. Not only does this help reduce information overload, but it also helps improve the tracking and managing of related emails.

- Get the relevant details in a simplified view. When you first view a conversation in the Reading Pane, Outlook shows you a conversation summary that contains a preview of all messages in the conversation — even if the email is located in other folder, such as your Sent Items. Simply click a message to quickly jump to that message and view the full details.

Figure 3 – View a conversation summary for a quick preview of the entire conversation or expand the conversation thread to view more details.

- Determine if there are unread messages in a conversation at-a-glance. The count of unread messages in a conversation is shown next to the message subject. When viewing the conversation summary, unread messages appear in bold along with the new mail icon.

- Quickly take action on conversation messages located in the same folder in just a few clicks. Select the conversation subject and assign all messages in the thread to a category, mark them as read, move or copy them to another folder, and more.
Quick Tips:

- It's easy to switch to the Conversations view. On the Organize tab, click Arrange By and then click Conversations.

- When viewing a conversation message, click the Show All button, located to the left of the message subject, to quickly jump to the conversation summary.

- For more information on using Conversations, see the section titled Exploring Conversations at the end of this guide.
Attachment previews

Save time viewing email attachments in Outlook 2011. Instead of opening file attachments for viewing in various applications, you can launch Quick Look to instantly preview your attachments in one easy step, without leaving your email.

- Use Quick Look to view almost every type of file attachment. Browse multiple page Office or PDF documents, view photos as slide show, play movies, and more. You can also switch to full screen view in Quick Look and get the most out of your screen real estate.

- Multiple file attachments? No worries. If your email contains more than one attachment you can open all of them in Quick Look in a single click. Simply click the Preview All button located to the right of the attachments.

- View your attachments at-a-glance. The Index Sheet in Quick Look enables you to switch to a thumbnail view so you can get an overview of your available file attachments. Click a thumbnail to quickly view that file in the previewer.

Quick Tip: Need to work with a file you’re previewing? Double-click a file in Quick Look to close the preview and open that file in its associated application.
Outlook database

Your Outlook database holds all of your Outlook content, such as your email, contacts, and calendars. You shouldn’t need to worry about losing your vital information if something goes wrong. Fortunately, with Outlook 2011 you can work with confidence, knowing your Outlook data will be available when you need it.

- Individual file store. Your Outlook data now is saved in separate text files, resulting in smaller, more robust and easier to manage files, which also makes your Outlook data directly Spotlight searchable.

- Use Time Machine to back up your Outlook data. Because your Outlook data is saved in separate, small files, your Outlook data can be backed up with the Time Machine utility on your Mac. Should something go wrong, or if you accidentally delete an important email or file attachment, you can easily go back in time and recover your needed files. Plus, Time Machine only backs up new or changed content, saving you valuable disk space and time.
Unified folders

These days, communication extends beyond a single mailbox. You may have email accounts from a variety of mail providers or more than one Exchange account. With Outlook 2011, you can easily access and manage them in one centralized location.

- Seamlessly work across your accounts. Outlook 2011 places your email, draft, sent and deleted items for all of your mailboxes in unified folders so you don’t need to check separate email accounts and multiple folders. To view items for a specific account, simply expand the unified folder for individual access, as shown below in Figure 5. (Note: If you prefer to keep your accounts separate, see the Quick Tip at the end of this topic.)

Figure 5 – Unified Inbox, Draft, Sent and Deleted Items folders make it easy to manage multiple email accounts in Outlook 2011.

- Improved account setup. Easily add email accounts stored on Exchange Server or from services such as Windows Live® Hotmail®, Gmail, AOL, MobileMe, Yahoo! or almost any other provider to Outlook 2011.5

Quick Tips:

- Your working style can be easily accommodated in Outlook 2011. To view each of your email accounts in separate folders, on the Outlook menu, click Preferences. Under Personal Settings, click General, and then deselect Group similar folders, such as Inboxes, from different accounts.

- Messages in an IMAP folder that are marked for deletion are automatically hidden by default. To show messages marked for deletion, from the Outlook menu click Preferences and then under the Email section, click Reading. Access the Hide IMAP messages marked for deletion option near the bottom of the dialog box.

5 Exchange Server 2007 SP1 Roll-up 4 or later is required for Exchange mailboxes. Some third-party providers require a fee-based subscription.
Import Windows PST files

Using both a Mac and a Windows PC? Transferring your Outlook information from Windows to Mac has never been easier. Outlook 2011 enables you to import data files (.PST files) created in Outlook for Windows directly in the application. No third party tools required.

Figure 6 – Access the Import feature on the File menu.

6 Import functionality is available for PST files created in Outlook 2003 for Windows or later.
Filter by Category

Outlook 2011 gives you the freedom to create multiple calendars in a single view. Bring together your personal, business, or family appointments on your calendar and view — or print — it as a separate calendar whenever you choose. All it takes is a few clicks to filter your calendar down to a specific category and hide information that doesn’t pertain to your task at hand.

- Organize your calendar on your terms. Use a built-in category, rename or delete an existing category, change the color, or create custom categories — it’s up to you. Renamed and newly added categories automatically appear in your Navigation pane by default, no additional steps are required.

- Assign multiple categories for even more flexibility. If a meeting or appointment fits more than one category, you don’t have to choose which category is the best fit. Associate it with all of the relevant categories and it will be included for each category filter.

Figure 7 – Easily hide or show appointments and meetings — including pending meeting invitations — for select categories on your calendar with a few simple clicks.

Note: Filter by Category is also available in your Contacts, Tasks, and Notes views.
Quick Tips:

- Want to see only specific categories for your available category filters? On the Organize tab, click Categories, and then deselect those categories you want to exclude from your Navigation pane.

- Easily adjust the number of hours you see on your calendar. When using a calendar view that shows a timeline, you can quickly change the number of hours you see through the Scale slider, located on the status bar and on the Organize tab. Just drag the slider and instantly adjust the timeframe.
Improved!

**Filters and Search tools**

Searching for a specific item can seem daunting — especially when you don’t have time to sift through every folder and read each piece of content. Fortunately, with Outlook 2011 you can easily find what you need when you need it using a variety of tools.

- **Filters**: Quickly filter your mailbox in a few simple clicks with built-in filters that provide you with frequently-used criteria — no typing required.

![Image of search filters](image)

Figure 8 – Select from quick filters such as Unread Only, Has Attachment Only, Date Sent, Date Received, and more.

- **Search tools**: Contextual Search tools, shown in Figure 9, automatically appear in the ribbon when you apply a built-in Filter or click in an Instant Search text box. You can use the Search tools to add additional criteria into your applied Filter to narrow your results even further or use them to create a new Filter from scratch.

  - Opt to include items with file attachments greater than a specified size, from a specific recipient, and more.

  - Quickly refine your search location to broaden your search and include subfolders, all email messages, or all Outlook items.

  - Use the Advanced Search option to add even more criteria and fine-tune your filter.
Figure 9 – Let Outlook do your searching for you and use the Search tools to help you build search criteria so you can find what you need when you need it. Then, save that search as a Smart Folder to automatically do the same search at a later time.

Note: The options available on the Search tab will change depending on your specific view. For example, if you’re viewing your contacts, you’ll see filter options such as Company, Has Phone, Has Address, and more.

Quick Tips:

- Smart Folders, formerly known as Mail Views in Entourage, enable you to save a Filter for easy reuse so you can apply it at any time. After you apply a built-in filter or use the Search tools to create a Filter, click the Save button on the Search tab to save your filter criteria and add it to your Smart Folders list on your Navigation Pane. To use a Smart Folder, simply click your saved Smart Folder and your Filter will instantly be applied.

- When you type in an Instant Search box, AutoComplete suggestions will dynamically display to help refine your search. To use a suggestion, click an item in the list or press your DOWN arrow key to highlight the suggestion and then press RETURN.
Help

Get started right away with video tutorials, take self-paced, easy-to-follow online tutorials, and access a wide range of help resources from one centralized online location. Office 2011 gives you more choices for fast answers that make it easy to get started or to take your work in Outlook to a new level.

- The welcome screen you see when you first start Outlook 2011, shown in Figure 10, helps you get your mailbox set up right away. Click the Add Account button to connect to an Exchange account, or other mail provider, or click Import to transfer your data files from Entourage or Outlook for Windows.7

- Also on the Help menu, click Get Started with Outlook to open an online site where you can access a wide range of resources.

- Or, click Outlook Help for the familiar help dialog box and the option to go online to explore the full range of help videos, self-paced tutorials and more.

Figure 10 – On the Help menu, just click Welcome to Outlook to access these windows at any time.

7 Import functionality is available for PST files created in Outlook 2003 for Windows or later and data files created in Entourage 2004, Entourage 2008, and Entourage EWS.
Quick Tip: Did you know that you can get answers to your Office for Mac questions from your peers, experts who volunteer their time, and folks on the Office for Mac product team? Check out the Office for Mac forums and search to see if someone else has already asked your question or post a question yourself. You can also check out the Office for Mac blog, where the product team frequently posts tips, tricks, and information about new and interesting features. Access both the forums and the blog from [http://microsoft.com/mac](http://microsoft.com/mac).
Rich email editing

You already use rich formatting tools such as, hyperlink insertion, strikethrough formatting, and text highlight in your Office documents why shouldn’t you have the same tools when you compose an email? Thankfully, Outlook 2011 doesn’t limit your formatting to the bare essentials; it gives you these tools so you can create professional and compatible emails. Along with the features listed above, here are some additional email editing improvements in Outlook 2011:

- Support for tables. Previous email applications for Mac Office enabled you to view tables in a received email, but if you forwarded or replied to that email, the table would be destroyed. In Outlook 2011 the table structure — and its formatting — will be maintained, as shown below in Figure 11.

Figure 11 – Forward or reply to an email with confidence, knowing that the original message format will be maintained.
- Multilevel lists. Not every list fits a single outline level; in Outlook 2011, you can easily give your lists structure. After you add a bullet or numbering format, press the TAB key or click the Increase Indent button to demote a list item. To promote a list item, click the Decrease Indent button.

- Characters palette. There's no need to download a third-party tool or switch to another application in order insert special characters or symbols in your emails. A searchable characters palette is accessible right from the Edit menu in Outlook 2011.

**Note:** Rich email editing tools are also extended to your meeting invitations and appointments as well as your contacts and notes.
Media Browser

Email isn’t always about text. Dynamic and compelling multimedia can grab the attention of your readers and help you more easily convey your message. The new and improved Media Browser is now available across the Office for Mac 2011 applications and consolidates your photos, movies and audio files, all in one convenient, searchable location. Just drag a file from the Media Browser to your email for quick insertion.

Figure 12 - Easily insert photos, audio files, and movies from the new and improved Media Browser in Outlook 2011.

- All of your media at your fingertips. Access your iPhoto libraries and iTunes playlists directly from the Photos and Audio tabs. You can also access movies and iMovie projects that you save to the Movies folder right from the Movies tab.¹

- Need to adjust the previews? Simply drag the zoom slider in the browser to customize your view for larger previews or to view more objects at one time.

Quick Tip: If you have an audio or movie file selected, click the play button beside the search box to play the selected object without leaving the Media Browser.

¹ All of your media at your fingertips. Access your iPhoto libraries and iTunes playlists directly from the Photos and Audio tabs. You can also access movies and iMovie projects that you save to the Movies folder right from the Movies tab.
Work more easily with others

When you need to work with other people, you shouldn’t have to worry about whether they work on Mac or Windows, or how you’re going to share and manage your schedules. Outlook 2011 takes care of those details for you with seamless cross-platform collaboration tools that help you get exactly the results you want every time.
Overlay calendar view

When working with multiple calendars, such as a shared Exchange calendar, it can be difficult to spot differences or open time availability when you’re switching back and forth between calendars. Fortunately, Outlook 2011 makes viewing multiple calendars a breeze by consolidating them in an easy-to-manage view. Simply open another user’s calendar and it will automatically be layered with yours and the details visually merged, enabling you to view your schedule and your colleagues’ schedule as a single calendar.

Figure 13 – When you select a calendar in the Navigation pane, the calendar details for that calendar will appear bold, making it easy to keep track of each person’s specific schedule.

Quick Tips:

- Click the check box next to Shared Calendars and turn on or off the display of all shared calendars in a single click. Or view an individual calendar by deselecting all other calendars in the Navigation pane.
- To view a calendar in a separate window, right-click (or hold the CONTROL key and click) the calendar in the Navigation pane and then click Open in New Window.
Calendar preview

Handling a meeting invitation usually involves three steps — reading the invitation, checking your calendar, and responding to the request. In Outlook 2011, when you receive a meeting invitation a calendar preview is included to help you better understand how it affects your calendar without leaving your inbox.

- Instantly review your calendar. Conflicts, adjacent items, and pending invitations are shown in the calendar preview so you can read the request and check the date on your calendar at the same time.

Figure 14 – Save time by reviewing your calendar as you take action on a meeting invitation.
Scheduling Assistant

If you’re an Exchange user, the Scheduling Assistant in Outlook 2011 makes it easy to schedule and manage your meetings more efficiently by combining new tools with familiar features you already know.

- Easily set your meeting time. Use the timeline at the top of the Scheduling Assistant to quickly find an open slot and then simply click to set the meeting start and end times.

- View more details for your colleagues’ schedules. If you have permission to view a person’s calendar details, appointment subjects now display in line with free/busy information, as shown below in Figure 15.

Figure 15 - Hover your mouse on an appointment to view a ScreenTip that reveals more information, such as appointment location.
Quick Tips:

- **Set your calendar permissions on your terms.** When using Exchange 2007 or later, give others permission to view limited calendar details, such as free/busy time along with only the subject and location, without giving them access to your entire calendar. To view and set your calendar permissions, from your Calendar view, on the Home tab, click Permissions.

- **Access your meeting agenda or other files that are relevant to your meeting right from your calendar.** When you add file attachments to your meeting invitation they will be sent with the invitation and saved with the meeting on your calendar. Or, attach your files later and send them in a meeting update. To view attachments, simply open the meeting invitation, on the Meeting menu, point to Attachments and then click Preview All.

- **Easily track responses right from your meeting invitation.** If you’re the meeting organizer, just open meeting from your calendar and display the Scheduling Assistant. The icon to the right of each name indicates their response, giving you quick at-a-glance details.

- **Manage your attendee list more efficiently.** In Outlook 2011, it’s easy to identify an optional attendee or set a resource for your meeting. Use the Contacts Search panel and set attendee status as you add a person to your meeting invitation. Or, in the attendee list, simply click the icon to the left of a name and select the desired status from the pop-up, as shown above in Figure 15.
Reply with Meeting

Consider the number of times you’ve received an email that either should have been a meeting invitation initially or escalated to a scheduled meeting for a face-to-face discussion or conference call. Also consider the number of steps you took to create the meeting invitation, (such as creating a new meeting invitation and addressing it to those included on the email exchange). What if you could perform those steps in a single click? With Outlook 2011, that’s exactly what you can accomplish. Not only does this save time, it also helps prevent inadvertently excluding someone from the invitation since Outlook automatically transfers the email recipients to your meeting invitation.

![Figure 16 – Click the Meeting button on the Home tab and your current email will be transformed into a new meeting invitation.](image-url)
Rich presence and on-the-spot communication

See availability and keep in touch with your contacts instantly. By using Microsoft Communicator for Mac or Microsoft Messenger for Mac, you can view presence information for those on your contact list. Easily connect to your colleagues and friends — even if they’re on another platform — without switching to another application.

- Hover your mouse pointer on a presence icon to display the new contact card, shown in Figure 17, and then easily initiate a conversation directly through instant messaging, voice, or video call.

Figure 17 – Get a variety of communication options and view contact information on the new contact card.

- Get enhanced functionality. With Office Communicator, you get additional tools, such as desktop sharing. When combined with Exchange Server, online availability is synchronized with your calendar and your calendar status is displayed at the top of the contact card.

Quick Tip: Easily add new contacts to your Messenger or Communicator contact list from the contact card. On the contact card, click the Add Contact button, the last icon on the contact card, to send them an invitation.

---

9 Viewing presence information and initiating an IM, voice, or video conversation from within Outlook 2011 requires either Microsoft Messenger for Mac 8 or Microsoft Office Communications Server 2007 R2 with Microsoft Communicator for Mac 2011. Your computer must have an installed microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator for Mac.
New!

Contacts Search panel

Your contacts play an essential role in your daily communications. You might schedule multiple meetings or send numerous emails a day. With Outlook 2011, your contacts are within easy reach and readily available in all of your Outlook views. The Contacts Search panel enables you to quickly search for a contact and send them an email or meeting invitation right from your search results.

- Instantly search your contacts. Start by typing the name of your contact or information found in other contact fields, such as a job title or phone, and those contacts that match your search string automatically display.

- Find your contacts faster with visual clues.
  Personalize your contacts with their photo, company logo, or any image to help make them easier to locate in your search results.

Figure 18 - The Contacts Search panel remains on top of other Outlook windows so it’s readily available whenever you need it.

Quick Tips:

- Quickly address your emails and meeting invitations using drag and drop. Simply drag a contact, or a group of selected contacts, from the Contacts Search panel to your desired address line, such as the To or Cc fields. To group contacts, hold the COMMAND key and click each contact. To quickly select a range of contacts, click the first contact in your desired range, hold the SHIFT key, and then click the last contact in the range.

- To use the keyboard to display the Contacts Search panel, press COMMAND + 0.

- Need to view more details for your contact? Double-click a contact in the Contacts Search panel to display their full contact details.
Information Rights Management

Protect your sensitive business information and content using a rich set of enterprise-level protection features. Information Rights Management is now available on the Mac platform and enables Windows and Mac users to share secure email transactions more easily.\(^\text{10}\) Your communications can be protected from unauthorized access and you can enforce those restrictions even if your email is distributed outside of your organization.

- Predefined permissions. Your system administrator can add custom permissions ranging from Do Not Reply All to specifying permissions by group, making it easy for you to select exactly the permissions you need.

Figure 19 – Access IRM permissions for an email on the Options tab.

Note: The default IRM option is Do Not Forward which also prevents recipients from printing and copying email content.

\(^{10}\) Creating IRM-protected documents with Office for Mac 2011 requires the volume license edition of Office 2011, as well as a Rights Management server running Windows Server 2008 R2 SP1. Opening IRM-protected content to which you have been given access can be done from any edition of Office for Mac 2011 or from Office for Windows 2003 or later.
Work how, when, and where you choose
It's easy to stay on top of your communications and your schedule when you can work when and where you choose.
Microsoft Outlook Web App

Exchange Server 2010 makes it easy for you to manage your Outlook 2011 emails, calendars, and contacts by providing access to your work from virtually anywhere. How do we do it? The answer is by making your email available through almost any computer, iPhone, or web browser — including Safari and Firefox on the Mac — through Outlook Web App. Now you can stay up to date with all the information you want when you want it.

- Access your account through a web browser. View and manage your email messages, contacts, and calendar events stored on Exchange Server.

- Work with a familiar environment. Use features found in Outlook 2011 such as Conversations, presence information, multiple calendars, shared calendars, organization hierarchy, free/busy status, and more.

Figure 20 - Access your email from virtually anywhere through Outlook Web App.

---

1 Web and smartphone access require an appropriate device and an Internet connection. Web functionality uses Outlook Web App, which requires Microsoft Exchange Server 2010 and a supported Safari 4 or later for Mac, Internet Explorer® 7 or later for Windows, and Firefox 3.5 or later for Windows, Mac, or Linux. There are some differences between the features of Outlook Web App and Outlook 2011.
Offline Address Books

Whether you manage your own Exchange Server or if your Exchange services are hosted by Microsoft, you can access directory information from the global address list anytime, anywhere — even if you’re not connected to the network. Offline address books enable you to keep working if the connection to your Exchange server is interrupted or while you’re traveling and a connection isn’t available.

- Transparent updates. Outlook 2011 automatically updates your offline address books so you can work seamlessly whether you’re online or offline.
Voice mail preview

With Outlook 2011 and new technology in Exchange Server 2010, a voice-to-text preview of a recorded voice message is sent along with the voice mail recording directly to your inbox. Access your messages virtually anywhere using a web browser, computer, or iPhone.

- Protected voice mail helps to secure and limit voice mail to only their intended recipients.

12 Requires Microsoft Exchange 2010 and Microsoft Exchange Unified Messaging.
Exploring Conversations

As you have read in this guide, Conversations help you track related emails and reduce information overload. Here are some tips for working with the Conversations feature so you can take advantage of everything it has to offer.

Make the switch to Conversations

It only takes a few simple clicks to switch to the Conversations view:

- On the Organize tab, click Arrange By, and then click Conversations, shown below in Figure 21.

- To make Conversations your default view, click Arrange By a second time and then click Make This the Default View.

Figure 21 – Easily view a folder by Conversations.
Conversations: General Tips

- When you first select a conversation, you'll see a summary of the discussion in the Reading Pane which helps you quickly get up to speed. The conversation summary also shows you messages that are located in other folders so you can view the entire conversation at-a-glance. For example, if you are viewing a conversation in your Inbox and you replied to a message in the conversation, even though your reply is placed in your Sent Items folder, it will display when viewing the conversation summary, as shown in Figure 22.

![Conversation summary](Image)

**Figure 22** — Preview all messages in a conversation at-a-glance.

- To see the individual messages in a conversation thread, click the arrow to the left of the conversation to fully expand it. When you expand a conversation in the contents pane, Outlook automatically jumps to the earliest unread message in the conversation so you don’t need to determine which messages you haven’t read. If you don’t see conversation summary or an arrow next to a message then there are no replies to that message.

- When viewing a conversation summary in the Reading Pane and you click a message to display it, if the message is located in another folder, such as in your Sent Items folder, it will display in an individual message window.

- You can quickly jump back to the conversation summary at any time. Simply click the Show All button, located to the left of the message subject, as shown in Figure 23.
Setting preferences for Conversations

You can use the following options to customize how you view messages in a conversation and tailor the Conversations feature to your specific style:

- Expand only one conversation at a time
- Automatically expand a conversation when selected
- Highlight messages from the same conversation

To modify how you view your conversation threads, on the Outlook menu, click Preferences, and then click Reading to display the options for Conversations, shown in Figure 24.
If you’re not familiar with how these options will affect what you see when using Conversations, additional information about each option is provided below.

**Expand only one conversation at a time**

- The Expand only one conversation at a time option is turned on by default. When this option is enabled, Outlook will automatically collapse an expanded conversation when you select another conversation. This helps save screen real estate and the need to manually collapse your conversations.

**Automatically expand a conversation when selected**

- The option to Automatically expand a conversation when selected enables you to by-pass the initial conversation summary when you first click a conversation and jump to the earliest unread message.

**Highlight messages from the same conversation**

- By default, when you first expand a conversation, Outlook will shade the background for all associated messages to help you visually keep track of the conversation. Figure 25 shows a conversation with the Highlight messages from the same conversation option enabled on the left and with the option disabled on the right.

![Figure 25](image)

Figure 25 – A conversation thread with and without the highlight option.

With Conversations, it’s easy to get up-to-speed on lengthy email discussions and help reduce information overload so you can get more done in less time.
Conclusion

Outlook 2011 is designed to help you work across platforms and help you stay on top of your communications. With a familiar look, Outlook 2011 provides a single location for your essential information, intuitive and easy-to-use email management and scheduling tools, bringing you the latest in personal information management to help you manage your day more efficiently.

When combined with Exchange Server 2010, you can obtain anywhere access to your information and stay connected and in touch with your world at work, at home, virtually anywhere.
### Create Incredible Content
Manage your content more easily

<table>
<thead>
<tr>
<th>Features and Benefits</th>
<th>Where to Find</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New!</strong> Ribbon</td>
<td>- The ribbon appears at the top of the screen below the toolbar.</td>
</tr>
<tr>
<td><strong>Improved!</strong> My Day</td>
<td>- On the Window menu, click My Day.</td>
</tr>
</tbody>
</table>
| **New!** Conversations| - To switch to the Conversations view:  
  - On the Organize tab, click Arrange By, and then click Conversations. |
| **New!** Attachment previews | - View an email with at least one file attachment. To the right of the file attachments, click Preview All.  
  To preview a single file attachment:  
  - Click once on the attachment you wish to preview and then click Preview. |
| **New!** Unified folders | - Unified folders appear automatically in the Navigation pane when using more than one email account.  
  To manage or add a new email account:  
  - On the Tools menu, click Accounts. |
| **New!** Import Windows PST files | - To import a PST file:  
  - On the File menu, click Import. |
<table>
<thead>
<tr>
<th>Features and Benefits</th>
<th>Where to Find</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New!</strong> Filter by Category</td>
<td>View your calendar or contacts. In the Navigation pane, click the check box to the left of a category to display or remove that category from your view. <strong>To show all categories:</strong> Click the check box next to the name of the calendar to quickly redisplay all calendar details. <strong>To show or hide a category in the Navigation pane:</strong> View your calendar or contacts. On the Organize tab, click Categories. Use the check boxes to the right of the category names to turn the display on or off.</td>
</tr>
<tr>
<td><strong>New!</strong> Adjustable timeframes</td>
<td>View your calendar in Day, Work, or Week view. On the Organize tab, above Scale, drag the slider to adjust the hours shown.</td>
</tr>
<tr>
<td><strong>Improved!</strong> Filters</td>
<td>From your Mail view, on the Home tab, click the arrow next to Filters to display a list of quick filter options.</td>
</tr>
<tr>
<td><strong>Improved!</strong> Search tools</td>
<td>When a filter is applied the Search tab will automatically display. <strong>To display the Search tools without applying a Filter:</strong> In any view, place your insertion point in an Instant Search text box. The Search tab will automatically display.</td>
</tr>
<tr>
<td><strong>Improved!</strong> Smart Folders</td>
<td>Smart Folders automatically appear in the Navigation pane. <strong>To create a new Smart Folder:</strong> Apply a Filter to your current view. On the Search tab, click Save.</td>
</tr>
<tr>
<td><strong>Improved!</strong> Help</td>
<td>On the Help menu, click Get Started with Outlook to visit the Office for Mac help site for Office 2011, with a range of resources including tutorials, videos, and help topics.</td>
</tr>
</tbody>
</table>
### Features and Benefits

<table>
<thead>
<tr>
<th>Feature</th>
<th>Where to Find</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New and Improved!</strong></td>
<td></td>
</tr>
<tr>
<td>Rich email editing tools</td>
<td>In a new email:</td>
</tr>
<tr>
<td></td>
<td>- Access Strikethrough, Highlight Color, Justify Text, and Hyperlink on the Message tab.</td>
</tr>
<tr>
<td></td>
<td>- To demote items in a multilevel list, press TAB or click the Increase Indent button.</td>
</tr>
<tr>
<td></td>
<td>- To promote items in a multilevel list, click the Decrease Indent button.</td>
</tr>
<tr>
<td></td>
<td>- To view the Characters palette, on the Edit menu, click Special Characters.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Improved!</th>
<th>Media Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do one of the following:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- On the View menu, click Media Browser.</td>
</tr>
<tr>
<td></td>
<td>- In a new email, on the Message tab, click Picture and then click Photo Browser.</td>
</tr>
</tbody>
</table>

### Work more easily with others

<table>
<thead>
<tr>
<th>Feature</th>
<th>Where to Find</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New!</strong></td>
<td></td>
</tr>
<tr>
<td>Overlay calendar view</td>
<td>Multiple and shared calendars automatically open in Overlay view.</td>
</tr>
<tr>
<td></td>
<td>To open another user’s calendar:</td>
</tr>
<tr>
<td></td>
<td>- View your calendar. On the Home tab, click Open Calendar. Type the user’s name and then click OK.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New!</th>
<th>Calendar preview</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Automatically appears when you receive a meeting invitation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Improved!</th>
<th>Scheduling Assistant</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In a new meeting invitation, on the Meeting tab, click Scheduling.</td>
</tr>
<tr>
<td></td>
<td>To change an attendee or resource status:</td>
</tr>
<tr>
<td></td>
<td>- In the Attendee list, click the icon to the left of a name and then click the desired status.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New!</th>
<th>Reply with Meeting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Select an email in your inbox. On the Home tab, click Meeting.</td>
</tr>
<tr>
<td></td>
<td>- From an open email, on the Message tab, click Meeting.</td>
</tr>
</tbody>
</table>
### Features and Benefits

<table>
<thead>
<tr>
<th>New and Improved!</th>
<th>Rich presence and on-the-spot communication</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• See availability of others when viewing a name on almost any Outlook item.</td>
</tr>
<tr>
<td></td>
<td>• Hover your mouse pointer on a presence icon view the contact card.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Viewing presence information and initiating an IM, voice, or video conversation from within Outlook 2011 requires either Microsoft Messenger for Mac 8 or Microsoft Office Communications Server 2007 R2 with Microsoft Communicator for Mac 2011. Your computer must have an installed microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator for Mac.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New!</th>
<th>Contacts Search panel</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• From any Outlook view, on the Home tab, click Contacts Search.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New!</th>
<th>Information Rights Management</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• From a new email, on the Options tab, click Permissions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Creating IRM-protected documents with Office for Mac 2011 requires the volume license edition of Office 2011, as well as a Rights Management server running Windows Server 2008 R2 SP1. Opening IRM-protected content to which you have been given access can be done from any edition of Office for Mac 2011 or from Office for Windows 2003 or later.</td>
</tr>
</tbody>
</table>

### Work how, when, and where you choose

<table>
<thead>
<tr>
<th>Improved!</th>
<th>Access your email on the web</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Outlook Web App, formerly known as Outlook Web Access, will continue to be available to Exchange 2010 customers as part of their standard licensing agreement.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>New!</th>
<th>Offline Address Books</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Offline address books automatically update.</td>
</tr>
<tr>
<td>Features and Benefits</td>
<td>Where to Find</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------</td>
</tr>
</tbody>
</table>
| **New!** Voice mail preview | ▪ Voice mail previews will appear in your inbox.  
**Note:** Requires Exchange 2010 and Exchange Unified Messaging. |
# Application Comparison

<table>
<thead>
<tr>
<th>Feature\Benefit Included</th>
<th>Improved</th>
<th>New</th>
</tr>
</thead>
</table>

## Manage your content more easily

Get easier access to the right tools, at the right time

<table>
<thead>
<tr>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ribbon</strong></td>
<td></td>
</tr>
<tr>
<td>The ribbon makes it easy to discover and utilize the features Outlook 2011 has to offer. It adapts to your task at hand and provides you with the tools you need when you need them.</td>
<td>☑</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>My Day</strong></td>
<td></td>
</tr>
<tr>
<td>Stay on top of your day at-a-glance. More tools for managing your tasks have been added along with the ability to view additional details for your upcoming meetings and appointments without the need to keep Outlook running.</td>
<td>☑</td>
</tr>
</tbody>
</table>

## Save time viewing, creating, and managing your email

<table>
<thead>
<tr>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conversations</strong></td>
<td></td>
</tr>
<tr>
<td>Get a summary of an entire conversation thread and update yourself on the pertinent details at-a-glance. The Conversations feature improves the tracking of related emails and lets you manage large amounts of email with ease.</td>
<td>☑</td>
</tr>
<tr>
<td>Feature</td>
<td>Entourage 2008</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Attachment Previews</strong></td>
<td></td>
</tr>
<tr>
<td>Launch Quick Look right from your email message and preview your file attachments without opening them in the application.</td>
<td></td>
</tr>
<tr>
<td><strong>Outlook database</strong></td>
<td></td>
</tr>
<tr>
<td>Outlook 2011 data is saved in separate text files, resulting in smaller, more robust and easier to manage files and can be easily backed up with Time Machine.</td>
<td></td>
</tr>
<tr>
<td><strong>Unified folders</strong></td>
<td></td>
</tr>
<tr>
<td>Outlook 2011 combines your inbox, draft, sent and deleted items folders for all of your mailboxes in unified folders, enabling you to work seamlessly across multiple accounts.</td>
<td></td>
</tr>
<tr>
<td><strong>Import Windows PST files</strong></td>
<td></td>
</tr>
<tr>
<td>Migrating from Windows to Macintosh has never been easier. Outlook 2011 enables you to import data files (PST files) created in Outlook for Windows directly in the application — no third-party tools required.</td>
<td></td>
</tr>
<tr>
<td><strong>Filter by Category</strong></td>
<td></td>
</tr>
<tr>
<td>The Filter by Category feature enables you to view your calendar and contacts items assigned to the categories you specify in a few quick clicks. View exactly what you need, when you need it.</td>
<td></td>
</tr>
<tr>
<td>Filters</td>
<td>Entourage 2008</td>
</tr>
<tr>
<td>---------</td>
<td>--------------</td>
</tr>
<tr>
<td>Quickly sift through your mailbox and find what you’re looking for with ease. Use built-in Filters to apply frequently-used criteria in a few simple clicks.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Search tools</th>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search tools automatically appear in the ribbon when you apply a built-in Filter or click in an Instant Search text box. Use the Search tools to add additional criteria into your applied Filter to narrow your results even further or use them to create a new Filter from scratch.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help</th>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explore a range of videos to help you get started with Outlook 2011 as well as expanded help resources including tutorials, videos, and help topics.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Deliver polished and professional communications**

<table>
<thead>
<tr>
<th>Rich email editing tools</th>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outlook 2011 brings you rich composition tools to help you easily create professional content. With increased cross-platform compatibility, rich formatting, such as tables, won’t be destroyed when you reply to or forward an email.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Page 50
### Media Browser

The Media Browser consolidates your photos, movies, and audio files, all in one convenient location. Just drag a file from the Media Browser to your email for quick insertion.

### Work more easily with others

#### Simplify your scheduling tasks

<table>
<thead>
<tr>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overlay calendar view</strong></td>
<td>✔️</td>
</tr>
<tr>
<td>Outlook 2011 automatically consolidates and stacks multiple and shared calendars so you can easily see your schedule and your colleagues’ schedules in a single calendar view.</td>
<td>✔️</td>
</tr>
</tbody>
</table>

| **Calendar preview** | ✔️ |
| Instantly review any calendar conflicts or adjacent items in a calendar snapshot, shown in a meeting invitation, so you can read the request and check the date on your calendar at the same time. | ✔️ |

| **Scheduling Assistant** | ○ | ○ |
| View more of your co-worker’s shared calendar details and easily track attendee responses right from your meeting request. | ○ | ○ |
### Reply with Meeting

Schedule your meetings faster by transforming an email into a meeting invitation in one simple click.

**Note:** A similar feature is available in Entourage as an Apple Script.

### Connect with others and stay up to date

#### Presence

See availability of others when viewing a name on almost any Outlook item.

**Note:** Viewing presence information and initiating an IM, voice, or video conversation from within Outlook 2011 requires either Microsoft Messenger for Mac 8 or Microsoft Office Communications Server 2007 R2 with Microsoft Communicator for Mac 2011. Your computer must have an installed microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator for Mac.
<table>
<thead>
<tr>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contact card</strong></td>
<td>✔️</td>
</tr>
</tbody>
</table>

Hover your mouse pointer on a presence icon to display the new contact card, view your contact’s information, such as address and phone, or easily initiate a conversation through instant messaging, video or voice call.

**Note:** Viewing presence information and initiating an IM, voice, or video conversation from within Outlook 2011 requires either Microsoft Messenger for Mac 8 or Microsoft Office Communications Server 2007 R2 with Microsoft Communicator for Mac 2011. Your computer must have an installed microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator for Mac.

| **Contacts Search panel** | ✔️ |

Instantly search your contacts from any Outlook view. Start by typing the name of your contact or information in found in other contact fields, such as a job title or phone, and those contacts that match your search string automatically display.

| **Information Rights Management** | ✔️ |

Control access to your sensitive emails using enterprise-level protection tools.

**Note:** Creating IRM-protected documents with Office for Mac 2011 requires the volume license edition of Office 2011, as well as a Rights Management server running Windows Server 2008 R2 SP1. Opening IRM-protected content to which you have been given access can be done from any edition of Office for Mac 2011 or from Office for Windows 2003 or later.
Work how, when, and where you choose

Access your vital information virtually anywhere, anytime

<table>
<thead>
<tr>
<th>Outlook Web App</th>
<th>Entourage 2008</th>
<th>Outlook 2011</th>
</tr>
</thead>
</table>

Manage your email from any device that has a web browser. Use Outlook Web App and view your email messages, contacts, and calendar events stored on Exchange Server. Use familiar features found in Outlook 2011 such as Conversations, multiple calendars, shared calendars, organization hierarchy, free/busy status, and more.

**Note:** Outlook Web App, formerly known as, Outlook Web Access, will continue to be available to Exchange Server customers as part of their standard licensing agreement.

**Offline Address Books**

Easily access vital phone numbers, addresses, job titles and more, even if you’re offline.

---

1 Internet connection and supported Internet Explorer, Firefox or Safari browser are required.
Voice mail preview

With Outlook 2011 and new technology in Exchange Server 2010, a voice-to-text preview of a recorded voice message is sent along with the voice mail recording directly to your inbox. Access your messages virtually anywhere using your web browser, computer, or smartphone.

Note: Requires Exchange 2010 and Exchange Unified Messaging.
FAQ

About Microsoft Outlook 2011

1. What is Outlook 2011?
2. How can I use Outlook 2011?
3. What are some of the major updates to Outlook 2011 over Entourage?

Outlook 2011 System Requirements & Compatibility

1. Are there special system requirements for running Outlook 2011?
2. Can I use my data files from previous versions of Outlook or Entourage in Outlook 2011?
3. Do I need other products in order to use Outlook 2011 features?
4. Which browsers are supported for Outlook Web App?

Using Outlook 2011

1. Are there free Outlook 2011 resources and training available from Microsoft?
2. Can I customize Outlook 2011 based on how I use the product?
3. Can I access my email when I am away from my primary computer?
4. How do I access my content in Outlook 2011 from a web browser?
5. What can I do with my Outlook 2011 content in Outlook Web App?
6. What can I do with my Outlook 2011 content on my iPhone?

Buying Outlook 2011

1. Which Microsoft Office for Mac 2011 suites will include Outlook 2011?
2. Will Outlook 2011 be available for standalone purchase?
3. Can I try Outlook 2011 before I buy it?
4. Is there a cost for using Outlook Web App?

Outlook 2011 Feature-Specific Questions

1. How do I configure a new email account?
2. How do I set a default view for all of my email folders?
3. How do I color code my inbox?
4. How do I change my default view in Outlook?
About Microsoft Outlook 2011

1. What is Outlook 2011?

Outlook 2011 is communication software with simple-to-use tools that enable you send, receive, and manage email. Moreover, you can manage your contacts and calendar, and even share your calendar or other Outlook content with those who use the same Exchange Server. Outlook 2011 helps you create professional and polished emails, stay in touch with your friends, family, and colleagues, and manage your communications and schedule more easily than ever before.

2. How can I use Outlook 2011?

You’ll be able to work more efficiently with an intuitive user interface, along with advanced organizing, scheduling, and conversation management tools to help you stay on top of your daily schedule and communications and get things done. From business or personal email communication, to coordinating your family or team’s schedule, you can take advantage of tools ranging from Conversations to connecting to your friends and colleagues instantly. Outlook 2011 can help you manage your schedule stress-free and keep in touch with people who matter the most.

3. What are some of the major updates to Outlook 2011 over Entourage?

Outlook 2011 includes new and improved features as well as an improved working environment that was designed to help you accomplish more tasks, faster.

- Simplify how you access the features you need. The ribbon, which displays near the top of Outlook 2011, makes it easy to discover and utilize the features Outlook 2011 has to offer. It adapts to your task at hand and provides you with the tools you need when you need them.

- Manage large amounts of email with ease. Get a summary of an entire conversation thread and update yourself on the pertinent details at-a-glance. With the Conversations feature, dozens of emails can suddenly turn into just a few relevant items and enable you to gain control over your email to get more time back in your day to focus on other things.

- Preview file attachments and save time. Launch Quick Look right from your email message and preview your file attachments without opening them in the application.

- View multiple calendars in a single view. Outlook 2011 automatically consolidates multiple calendars in an overlay view (such as a shared Exchange calendar), so you can easily compare schedules without the need to switch windows.
- Manage your schedule stress-free. Efficiently schedule appointments, share your calendar availability, and manage your work schedule using easy-to-access calendar management and sharing tools. Get a preview of your calendar right from a meeting invitation so you can read the request and check the date on your calendar without leaving your inbox. Or turn an email into a meeting invitation in a single click and save time.

- Get access to your global address list even if you’re offline. New offline address books enable you to easily access vital phone numbers, addresses, job titles and more, even when you’re not connected to your network.
Outlook 2011 System Requirements & Compatibility

1. Are there special system requirements for running Outlook 2011?

Following are the recommended minimum system requirements for installing and running Office for Mac 2011:

<table>
<thead>
<tr>
<th>Computer:</th>
<th>A Mac computer with an Intel processor.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System:</td>
<td>Mac OS X version 10.5.8 or later.</td>
</tr>
<tr>
<td>Memory:</td>
<td>1 GB or higher recommended.</td>
</tr>
<tr>
<td>Hard Disk:</td>
<td>2.5 GB of available hard disk space.</td>
</tr>
<tr>
<td></td>
<td>HFS+ hard disk format (also known as Mac OS Extended or HFS Plus)</td>
</tr>
<tr>
<td>Web Browser:</td>
<td>Safari 5 or later recommended.</td>
</tr>
<tr>
<td>Installation:</td>
<td>DVD drive or connection to a local area network (if installing over a network).</td>
</tr>
<tr>
<td>Display:</td>
<td>1280 x 800 or higher resolution monitor.</td>
</tr>
</tbody>
</table>

**Additional requirements (may vary based on your edition of Office 2011):**

- Certain online functionality requires a Windows Live ID.
- Certain features require Internet access (fees may apply).
- Co-authoring and Broadcast Slide Show require Microsoft SharePoint Foundation 2010 (for enterprise) or a Windows Live ID (for personal or small business use).
- Exchange support in Outlook for Mac 2011 requires connectivity to Update Rollup 4 for Exchange Server 2007 Service Pack 1 or later.
- Access to files stored on a SharePoint site requires connectivity to SharePoint 2007 or later.
- Communicator 2011 requires an account on Microsoft Office Communications Server 2007 R2.
- The Photos, Audio, and Movies tabs of the Media Browser require (respectively) iPhoto 5 or later, iTunes 6 or later, and iMovie 3 or later.

To obtain system requirements for each Microsoft Office for Mac 2011 suite and standalone applications visit the Office for Mac website (http://www.microsoft.com/mac).

2. Can I use my data files from previous versions of Outlook or Entourage in Outlook 2011?

Yes. You can import data files created in Entourage 2004, 2008, and Entourage EWS as well as Outlook 2003 for Windows or later.
3. **Do I need other products in order to use Outlook 2011 features?**

   None of the creation or management tools in Outlook 2011 require other products. However, your Outlook experience is enhanced when used with following:

   - **Office Communicator 2007 R2 or later with Office Communications Server 2007 R2 or later or Messenger for Mac 8:**
     - Presence and additional contact card features: Quickly view the availability of your colleagues and with the new contact card you can reach out to them through instant messaging, video or voice call.
   - **Microsoft Exchange Server 2007 SP1 Roll-up 4 or later:**
     - Calendar status: Quickly view your colleagues’ calendar status, such as free until 2:00 p.m., on the new contact card.
   - **Microsoft Exchange Server 2010:**
     - Access voice mail previews from your inbox: A voice-to-text preview of a recorded voice message is sent along with the voice mail recording directly to your inbox.

4. **Which browsers are supported for Outlook Web App?**

   Supported browsers include Safari 4 or later for Mac, Windows Internet Explorer 7 or later for Windows, and Firefox 3.5 or later for Windows, Mac, or Linux.

**Using Outlook 2011**

1. **Are there free Outlook 2011 resources and training available from Microsoft?**

   You can access numerous free, self-help resources on the Office for Mac website [http://www.microsoft.com/mac](http://www.microsoft.com/mac). Resources include training courses, guides to help ease the transition from menu to ribbon, Help articles, and demos. In addition, you can access the Product Forums to get answers from your peers and independent experts in the community, such as the Microsoft Most Valuable Professionals.

2. **Can I customize Outlook 2011 based on how I use the product?**

   You can customize many aspects of Outlook 2011, including the following:
- Customize the Outlook toolbar. On the View tab, click Customize Toolbar. Drag new items to the toolbar to add them or drag existing items off the toolbar to remove them. You can also display an icon along with text or remove the icon display.

- Rename, add, or modify categories. On the Home tab, of the mail and contact view or on the Organize tab of your calendar view, click Categorize and then click Edit Categories.

- Set your preferences for a wide range of Outlook items and program behavior, ranging from setting defaults for your Outlook items, modifying AutoCorrect to changing your new message alerts and sounds, and managing your Sync Services. All of these settings and many more are available in the Outlook Preferences dialog box. To do this, on the Outlook menu, click Preferences.

3. **Can I access my email when I am away from my primary computer?**
   Using the new Outlook Web App, you can access your Outlook 2011 email and content from virtually any computer with an Internet connection. Additionally, you can access your Outlook content from your iPhone.

4. **How do I access my content in Outlook 2011 from a web browser?**
   Outlook Web App will be available to Microsoft Exchange customers. For personal email, you can add your Windows Live Hotmail account to Outlook and access it from Outlook 2011 or the web. Alternatively, you can go to the webmail interface of the email service you use, such as Hotmail.com or Gmail.com.

5. **What can I do with my Outlook 2011 content in Outlook Web App?**
   Manage your email from your device with a web browser. Use Outlook Web App and view your email messages, contacts, and calendar events stored on Exchange Server. Use familiar features found in Outlook 2011 such as Conversations, multiple calendars, shared calendars, organization hierarchy, free/busy status, and more.

6. **What can I do with my Outlook 2011 content on my iPhone?**
   You can easily access your email, calendar, contacts, and tasks from anywhere, anytime. If you’re an Exchange user you can also access your company’s global address list, calendars, and take advantage of direct push so you can receive updates automatically.

---

14 Microsoft Exchange Server 2010 required.

15 An appropriate device and Internet connection are required.
Buying Outlook 2011

1. Which Microsoft Office for Mac 2011 suites will include Outlook 2011?
Outlook 2011 is available as part of Office for Mac 2011 Home & Business.

To view a suite comparison for Microsoft Office for Mac 2011 so you can determine which suite is right for you, visit the Office for Mac website (http://www.microsoft.com/mac).

2. Will Outlook 2011 be available for standalone purchase?
No. A standalone version of Outlook 2011 is not available at this time.

3. Can I try Outlook 2011 before I buy it?
Yes. A trial version of Office for Mac 2011 will be available. Visit the http://www.microsoft.com/mac for more information.

4. Is there a cost for using Outlook Web App?
Outlook Web App, formerly known as, Outlook Web Access, will continue to be available to Microsoft Exchange customers as part of their standard licensing agreement.

Outlook 2011 Feature-Specific Questions

1. How do I configure a new email account?
From the Tools tab, click Accounts. In the Accounts dialog box, click the plus icon (+) in the bottom left corner to add a new account. In additional to Exchange Server, you can add almost any email account, including your email account from your Internet Service Provider, an Internet hosted email account, such as Windows Live Hotmail or Gmail.

2. How do I set a default view for all of my email folders?
To set a default view for all of your email folders, on the Organize tab, click Arrange By, select your desired default view, click Arrange By a second time, and then click Make This the Default View.

3. How do I color code my inbox?
To change the color of message details shown in the contents pane, such as to change the color for a specific message blue, you can utilize color categories. To automatically assign a color category to a specific individual, create a Rule. To access your Rules, on the Home tab, click Rules. After a Rule is created it will automatically run when the condition is met.
4. **How do I change my default view in Outlook?**

   You can easily change the layout of your Outlook window on the Organize tab. Such as:
   
   - Turn off the Navigation Pane or minimize the ribbon.
   
   - Hide or move the Reading Pane to the bottom of the contents pane.

   You can also display all or some of your Outlook shortcuts, found at the bottom of the Navigation pane, as small icons by dragging the sizing handle above the shortcuts.
Outlook Web App

- Supported browsers for Outlook Web App include Safari 4 or later for Mac, Internet Explorer 7 or later for Windows, and Firefox 3.5 or later for Windows, Mac, or Linux.

- Supported mobile browsers for Outlook Web App include Safari 4 on iPhone 3G and 3GS, Internet Explorer on Windows Mobile 5/6/6.1/6.5, BlackBerry 4.x and later, Nokia S60, NetFront 3.4, 3.5 and later, Opera Mobile 8.65 and later, Openwave 6.2, 7.0 and later.

Rich presence and on-the-spot communication

Rich presence and integrated communication tools in Office for Mac 2011 enable you to view the availability of other document editors and communicate with your contacts without leaving Word 2011. These capabilities have the following requirements:

- Viewing presence information and initiating an IM, voice, or video conversation from within Word 2011 requires either Messenger for Mac 8 or Office Communications Server 2007 R2 with Communicator for Mac 2011.

- Your computer must have an installed microphone for voice calls and an installed video camera to use the video capabilities in Messenger for Mac or Communicator for Mac.

This document is provided “as-is.” Information and views expressed in this document, including URL and other Internet website references, may change without notice. You bear the risk of using it.

Some examples depicted herein are provided for illustration only and are fictitious. No real association or connection is intended or should be inferred.

This document does not provide you with any legal rights to any intellectual property in any Microsoft product. You may copy and use this document for your internal, reference purposes.

© 2010 Microsoft Corp. All rights reserved.
Microsoft, Windows, Excel, Hotmail, Internet Explorer, Outlook, PowerPoint, Segoe, SharePoint, Visual Basic, and Windows Live are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

iMovie, iPhoto, iTunes and Safari are trademarks of Apple Inc., registered in the U.S. and other countries.

All other trademarks are property of their respective owners.
Colophon

This document was written in Word for Mac 2011 and Word 2010 for Windows. It was laid out entirely in Word 2011 using both Publishing Layout view and Print Layout view.

The TrueType fonts Segoe® and Segoe Light are the primary fonts used.

Screenshots were taken with Snapz Pro X and Snagit for Mac beta. Other art was done in PowerPoint for Mac 2011, PowerPoint 2010 for Windows, or directly in the final document, in Word 2011.

The final version of this document is distributed in PDF format, created from within Word 2011.